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INTRODUCTION:  
 
 
What Explorer Looks Like : 
 
 
Users sometimes find Windows Explorer very daunting.  In fact,  it is completely the 
opposite once you get to know it.   
 
Open Explorer by clicking on  Start \ Explorer,  or often,   Start \ Programs \ Windows 
Explorer. 

 
 

Left Side

Drives, directories (folders),
subdirectories (subfolders),

Right Side

The contents of what is
highlighted on the left side.

Separator

 
 
 

As you can see from above,  the Windows Explorer screen is divided up into two.  The 
pane on the left hand side shows the structure of drives, folders and subfolders, whilst 
the right hand pane shows the contents of what is selected in the left hand pane.  For 
example, if you double-click on a particular folder in the left hand pane, the contents of 
that folder will appear in the right hand pane. 
 
Sometimes to create more space, it may be necessary to alter the size of either the 
right or left Explorer panes.  If you run the mouse cursor over the ‘separator’ that 
separates the left Explorer pane from the right one you will see that the cursor changes 
to a double-sided arrow.  When this appears,  if you do a left mouse click and hold the 
button down you will notice that you will then be able to drag the separator to the right or 
left.  If you drag the separator to the left you will create more space for the right Explorer 
pane and vice versa. 
 
Note:  Throughout this document we will use  “Directories”  and  “Folders”, and 
“Subdirectories”  and  “Subfolders”  interchangeably – different words, same 
meaning ! 
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SETTING UP EXPLORER  

 
 

Click on the View menu and select Options.  Make sure that you are currently looking 
at the View tab, and then configure the options so that the ‘Options dialogue box’ 
appears identical to the one below.  Click on Apply and then Ok once completed. 
 
 
Windows 95 
 
 

It is very important to have the option
“Display the full MS-DOS path in the
title bar” selected.  This is so that you
know  exactly where you are in
Explorer.  For example, say you were
in a directory titled “BACKUPS” and
you didn’t have the full path option
selected.  On the title bar in Explorer it
would read “BACKUPS”.  The problem
with this is, you could have a hundred
“BACKUP” directories and unless you
have the show full path option
selected, Explorer will not display the
drive nor the parent directories to
where you are situated.

 
 
 

 
Windows 98/ME 
 
Click on  “Tools \ Folder Options”  and make sure the window that comes up is set up 
as shown below  (in time you may want to have different options, however, as a 
beginner, for the time being set your Explorer settings exactly as shown below : 
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Next, click on the  View  tab and set up your options exactly as shown below : 
 

  
 
 
Click  OK. 
 

 
 
 

To use Explorer to its full ‘potential’, it is a good idea to select the following options on 
the View menu. 
 
l The Explorer Toolbar offers you quick access to some of the most  used 

commands on the various menu’s, i.e. Cut, Copy, Undo etc. 
 
l When the Status Bar is selected, you are able to see the full path to where you 

are situated within Explorer, i.e. C:\Comms\Netscape\Program...etc.  
 
l When the Details option is selected, you are able to see the Name of the files 

and folders, their Sizes, their extension Types, and the last time that they were 
last Modified or created.  This information is displayed on the right hand screen. 
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Windows 98/ME 
 
 

Set these 4 options
(Win98/ME)  - 3 options only
in Win95.

 
 
 
 
Windows 95 
 
 

Set these 3 options.

...This information is displayed on the
right hand screen.
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LOOKING AT, AND ACCESSING, FOLDERS AND FILES  

 
 

As you can see, the Explorer I am using has been configured to open
so that you can see all of the directories and files on the C drive.  Your
Explorer may be configured in a different way - this is not a problem.  If
you click on the little square to the left of the C drive icon which
currently has a minus sign (-) in it, you will see that the contents of the
C drive will collapse, and if you re-click on the square again (this time it
has a plus (+) sign in it) the contents of the C drive will expand.
Another way to view or close the contents of drives or directories apart
from using these little squares, is to actually double-click on the icons or
folders!

 
 
If you refer to the screenshot above,  you will see that under the C:\ drive labelled 
“Michael 420(C:)” there are numerous folders (directories) one of which is called 
“Program Files”.  If I double click on that folder, nine other folders appear.  These nine 
folders are called sub-folders because they are folders within a folder. 

 

 
 

For example, one of the nine sub-directories that has appeared under the Program Files 
directory (the Parent directory) is called “Quick View Plus”.  If I double click on this 
sub-directory,  another four directories appear.  These directories are sub-directories of 
the Quick View Plus directory,  which is a sub-directory of the Program Files directory.  
Look at the pattern below... 

 

 
 

 
Parent Directory 

 
Sub-directories of the Program 

Files directory 
 

The Quick View Plus directory is a sub-
directory of the Program Files directory,  yet 

it is the parent directory to the directories 
beneath it ! 

 
Sub-directories of the Quick View Plus 

directory 

 
Sub-directories of the Program File 

directory. 
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Lets take a closer look at working with the two Explorer screens.  As you can see from 
the screen print overleaf,  the contents of the Winzip 95 directory (selected on the left 
hand screen) are on view in the right hand screen. 
 
 

 
 

Lets take a closer insight to the right hand Explorer screen.  Notice the screen is divided 
into four columns, Name, Size, Type and Modified. 

 

 
 

 
• Under the Name column is a list of all the Files and directories within a particular 

directory. 
 
• Under the Size column is the size of all these files and folders. 
 
• Under the Type column is a description of what type the file or folder is,  i.e. a Help 

file,  Word Document, File Folder etc. 
 
• Under the Modified column is the date,  the files or folders were last modified or 

created.   
 
 

 
Because the full path option is selected,  you 

know you are in the C:\Program Files\Winzip 95 
directory 

 
The contents of the 
Winzip 95 directory 

 

The Winzip 95 
directory has been 

selected.  
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SORTING FILES  

 
 

 
 
 

At the moment the files above are sorted in ascending order of name, however,  to suit 
you needs, you can sort the files in whatever order you want.  Just by clicking once on 
the “Name” button,  the files will now sort from ascending to reverse alphabetical order 
(‘Z’ to ‘A’);  click once more and they revert back to ascending alphabetical order.  This 
rule does not just apply to the Name button,  but also for the Size,  Type and Modified 
column headers also.   
 
l Name 
 You may want to view files and folders in ascending or descending order of 

Name, so that you can access them quicker.  For example, if you wanted to work 
with a file that started with the letter Z, rather than having to scroll to the bottom 
of the page to find the file, you could alternatively just do one simple click to sort 
the files in descending order, and there you would have the file you require to 
work with, right in front of you. 

 
l Size 
 You may want to view files and folders in ascending or descending order of Size, 

because you are trying to find a largish file, or a small file, for that matter.  Sorting 
the files in order of Size would simplify your search for the file in question. 

 
l Type 
 You may want to view files and folders in ascending or descending order of Type,  

so that, for instance, you can see all the Word documents bunched together.  In 
another example, you might be trying to locate all the screen-savers in the 
Windows directory (.SCR extension). 

  
l Modified 
 You may want to view files and folders in ascending or descending order of Date,  

because, for instance, you may want to open a certain file that you were working 
on the previous day, but cannot remember its filename.  If  you sort all of the files 
in descending order of date, the file you are trying to find will appear in the top 
section of the Explorer screen and at this point, you will be able to recognise the 
file that you wish to open. 

 
All of the files are currently sorted in alphabetical order.  

Just by clicking once on the “Name” button,  the files 
will then sort themselves in descending order.  This also 

applies to the Size, Type and Modified buttons. 
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CREATING DIRECTORIES  

 
 
In the examples below, I shall walk you through the process of creating folders and subfolders.  
Before you start however, the following points are crucial. 
 

l To create subfolders, you must first highlight the parent directory before 
selecting File, New, Folder. 

 
l To create parent folders, you must first highlight the specific drive 

before selecting File, New, Folder. 
 
 

r Click on your C:\ drive icon so that it appears highlighted.  Open the File menu 
and select New,  Folder (folder is an alternative name for a directory) and you 
will see that a new folder will appear at the bottom of the right hand screen 
prompting you to enter a folder name.  Its initial default name is  “New Folder”. 

 

 
 

r Type in a folder name and press enter - you have just created a directory and you 
will see that it now appears in the left hand screen as well as the right hand 
screen.  For reference, in our example the directory I have just created is called  
“Michael”. 

 

 
 

r Click on the directory you have just created on the left hand screen,  and click on 
the File menu selecting New,  Folder.  When you are prompted to enter a folder 
name, do so.  (For my example,  I am going to call the folder “Test”).  When you 
have entered the new folder name, press enter and you will see that you have 
now successfully created a sub-directory of the directory you created just 
moments before.   

 

 
 

 

Type in a folder name 

 
My example 
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DELETING FILES AND DIRECTORIES  

 
 

Deleting a single file 
 

r Click on the sub-directory you created (in my example it was called “Test”),  right 
click and you will see that a shortcut menu appears. 

 
r Select Delete from the shortcut menu that appears and you will then be prompted 

with the message “Are you sure you want to send this item(s) to the Recycle bin”.  
You then click on either yes to delete the item(s) or Cancel.  Alternatively, with 
the folders/files you want to delete highlighted,  you can just press the Delete key 
on the keyboard and that will also prompt you with the message stated above, 
asking you to confirm whether or not  you do want to send the item(s) to the 
recycle bin or cancel.  Please note, when you are deleting from a floppy disk or 
from a network drive, the message that prompts you to confirm the delete is 
different from the message that appears when deleting from your local drives.  
Even though all messages differ slightly, they all imply the same thing - are you 
sure you want to delete or not ? 

 
Deleting consecutive files 
 
r If you require to delete ‘consecutive’ folders/files (files that appear on the display 

one below the other), in the right-hand screen click on the first item you wish to 
delete so that it appears highlighted, hold the Shift key down on the keyboard 
and then click on the last item you wish to delete.  You have now selected a 
whole ‘consecutive’ selection.  Now either do a right click selecting delete from 
the shortcut menu that appears, or alternatively, just press the Del key on the 
keyboard. 

 

 
 
Deleting multiple selections of files 
 
r If you want to select a multiple selection of files/folders which are now necessarily 

showing in consecutive order on the screen, on the right-hand screen click on the 
first item that you wish to delete so that it appears highlighted, and then hold 
down the Ctrl key on the keyboard.  You can now click on other items and you 
will see that you can select a multiple range of items that do not appear to be in 
any particular order. Now, after releasing the Ctrl key, either do a right click on 
any of the selected items, and then select  Delete  from the shortcut menu that 
appears, or alternatively, just press the Del key on the keyboard. 

 

 



AnswersThatWork  Learning Windows Explorer 
 
 
 
 

Page 11 of 13 
 

 
© Copyright AnswersThatWork.com,  9-Feb-2002. 

  
The Recycle bin  
 
 
r Scroll down the left pane of Explorer and locate the Recycle bin icon, right click 

on it and select Properties, the ‘Recycle bin Properties dialogue box’ will now 
appear on screen.  Make sure that the same options are selected as below, 
clicking on Ok once completed. 

 
Note:  Due to the way your PC is configured, the tab(s) you may have in your 
‘Recycle bin Properties dialogue box’ may vary from the example below.  If you 
have a Global tab, select the following options in that tab and these options will 
apply to all drives. 
 

 
 
 

r As a test, set up a temporary directory and Copy some files at random into this 
directory.  Once completed, delete this directory, confirming the deletion. 

 
r Locate the Recycle bin and open it by double clicking on it.  Inside you will find 

the files that you have just deleted.  As you can see, when files/folders are sent to 
the recycle bin, they are actually still recoverable; this is a safety measure so that 
files you delete accidentally can still be recovered.   To recover a file, highlight it, 
right-click on it, and then choose  Restore. 
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COPYING FILES  

 
 

The best technique to use to copy files using Explorer is to work with two Explorer 
screens.  This allows you to have one screen which shows where you are copying from, 
whilst the second screen shows where you are copying to. 
 
r With one Explorer already open, open another by clicking on the Start button and 

selecting Explorer.  You will obviously not be able to view both screens at the 
same time,  but to switch between the two Explorer screens, simply click on the 
relevant button on the Taskbar. 

 

To switch between one Explorer screen to the
other, simply click on the relevant button on the

Taskbar.

 
 
 
r With all of the relevant ‘folders or files’ that you want to copy ‘highlighted’ on the 

right hand screen,  do a right click on any highlighted file or folder and select 
Copy from the shortcut menu that appears. (Alternatively you can also select 
Copy by pressing the key combination Ctrl + C, or by choosing the Edit \ Copy  
menu option).   

 
r Switch to the second Explorer screen and position yourself in the 

[Drive][Directory][Subdirectory] where you want the selected items copied to, do a 
right click anywhere in a white space in the right-hand windows and this time 
select Paste. (Alternatively you can also select Paste by pressing the key 
combination Ctrl + V, or by choosing the  Edit \ Paste  menu option).  You will 
now see a status window appear on screen with files moving from one folder to 
the other – this is your confirmation that the relevant files are being copied.   
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MOVING FILES  

 
 

r As with the copying of files in the previous section, the best technique to use 
when Moving files is again to work with two Explorer screens.   
 
With one Explorer already open, open another by choosing Windows Explorer off 
the Start button.   

 
r With the folders/files that you want to Move highlighted on the right hand screen,  

do a right click on the highlighted selection and select Cut - you  will notice that 
the items that you have just cut will suddenly become greyed out.  They will 
remain like this until you move them to their correct destination and at that point 
they will disappear from their original source folder.   

 
r By now you should have an idea as to what to do next.  Switch to the second 

Explorer screen, position yourself within the destination 
[Drive][Directory][Subdirectory],  and then do a right-click in a white space in the 
right-hand pane and select Paste.   

 
r Alternatively,  with all of the items that you require to move highlighted,  on the 

keyboard press the key combination Ctrl + X (which is the key combination for 
Cut).  When you are ready to paste the files,  position yourself in a white space in 
the destination folder and then press the key combination for Paste (Ctrl + V). 

 
r Alternatively again,  with all of the items to be moved highlighted,  choose the  

“Edit \ Cut”  menu option.  When you are ready to paste the files,  position 
yourself in a white space in the destination folder, and then choose the  
“Edit \ Paste”  menu option. 

 
 

Key combination Details 
Ctrl + C To Copy 

Ctrl + V To Paste 

Ctrl + X To Cut 

Ctrl + A To select all 
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